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APPOINTMENT: an activity that does not involve inviting other people or reserving
resources.

To create a new appointment, either open a new appointment form or type directly on the
calendar. Add a subject, location, starting time, etc., and a reminder if you wish. You can
designate the time an appointment takes as busy (displayed on the calendar with a dark
blue line), free (no line), tentative (light blue line), or out of office (purple line). Double-
click on an appointment on your calendar to open it, and single-click to select it.

ﬁ'Untitled-Appointment @ create an ADDOIntment

I File Edt Wiew Insert Format  Tools  Actions  Help

i ol Saveand Close | & (] | AOvRecurrence... | EInvice Attendees | 1 B | X | - v\-@! 1. In the mOnthly calendar pane,
Spporimert. | Sing select the month and date.

| T 2. In the schedule pane, double-click
Location: ~ | Label: Mone: hd . . .

the time when the appointment is

Start time; | Tue LOf12/2004 v [1oooam | a0 day event to begin_

End time: Tue 10f12/2004 | 130 AN v 3 The Untitled _- Appointment
[“]Reminder: |15 minutes v Show time as: | Il Busy v dialOg bOX appears, Wlth the

Appointment tab displayed.

4. In Subject text box, enter subject
of appointment.

5. In Location text box, enter
meeting place.

6. In Start time and End time,
enter dates and times (or use

prvate [] drop-down menus to display

calendars).

7. Select Reminder check box to specify when you want to be reminded.

8. In Show Time As drop-down list, choose how you want to display the time in your
calendar (and on the Exchange server, if you are on it).

9. Use the large text box to enter information you want to include about the meeting.

10. Click Categories button to assign a category to an appointment.

11.Click Save and Close button to return to the calendar.

Schedule a Recurring Appointment

Appointment Recurrence X Open the Calendar, and on the
Appaintment time toolbar choose Actions & New
Start: |WHOEME  v|  End: [10:30AM v | Duration: |30minutes v Recurring Appointment.
Recuence pattem 2. The Appointment Recurrence
O Daily Recur every |1 weekls) on: dlalog box app_ears on tOp of
@ weskly [J5unda [IMonda [v] Tuesda [Jwednesda AppOIntment dlalog bOX.

O onth ‘*’ . v ¥ v 3. In Appointment Time area, (_enter
S [ tharsday [Friday  []saturday Start, End, and Duration times.
Otearly 4. In Recurrence Pattern area,
Range of recurrence indicate the frequency of the
Start: | Tue 10712/2004 v | ©Hgend date appointment (Daily, Weekly,
(OEnd after: |10 | occurrences Monthly, or Yearly). When you
Ofndby: | Tue 12/14/2004 7 select an option, the Recurrence
Pattern choices change.
o | [ cancel | 5. Enter day, month, and other
options as needed.
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6.

In Range of Recurrence area, enter:

Start - date when recurring appointments begin

No End Date -

if appointments are not on a limited schedule

End After - if there is a specific number of appointments

End By -

if the appointments end on specific date

Click OK to close the Appointment Recurrence box

7. The Appointment dialog box appe
8. Fill in desired information, then cl

MEETING: an appointment to whi

ars
ick Save and Close button

ch you invite people and resources

Create a Meeting §ii Untitled - Meeting
! Fle Edt Wiew Insert Format  Took  Actions  Help
1. ChOOSE ACtiOI‘lS 9 Plan } :=95end =1 | (4 8, | 42¥Recurrence,.. 7 Cancel Invitation | ¢ U |>( | ‘E_J)H
M e etin g Appointment | Scheduling
2. Plan a Meeting dlalog bOX Zoom: | L00% (Day Yiew) v Tuesday, October 12, 2004
300 4:00 00 900 10:00 11:00 1z2:00 1:00
a p pea rs. All Attendee.s I |
3. Enter names of attendees or click o e e r— — -
on the Invite Attendees button
4. After you've selected the
attendees, press Enter.
5. Open Meeting Start Time drop
down list to select date from
calendar.
6. Open Meeting End Time drop . .
down list to select time. ot [ ] o
7. Note the time grid to the right of sbetrgendine: [ onzizeer [l [oonr I
each attendee name showing :
. - W Busy % Tentative M Outof Office [ Mo Information
availability.
8. When finished, click the Make Meeting button. The Meeting dialog box will appear
and you can enter the details.
9. When you're ready to send meeting invitations via email, click the Send button.

10. Close the window by choosing File = Close or click on the X in the upper right corner.

3

Calendar Options

Calendar work week

D?Sun Man Tue Wed Thu Fri [5at
First day of week: | Sunday “ | Startbime: | S:00 AM w
First week of year: |Starts onJan 1 + | Endtime: |5:00PM w
Calendar options
[]5haw week numbers in the Date MNavigator

e

Allow attendees to propose new times for meetings you organize
Use this response when you propose new mesking times: | Tentative £Y3
Background colar: v Flanner Options, ., ] [ Add Holidays...

[] use selected background color on all calendars

Advanced options

@ []Enable alternate calendar:

[ Eree/Busy Options. ..

) |

] [ Resource Scheduling.. . Time Zone. .. ]
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Set your Calendar Preferences

1. Go to Tools = Options
2. Go to the Preferences tab,
3. Click on the Calendar Options button.

This will open a dialog box that lets you
specify your calendar work week, Date
Navigator week numbers, calendar
background color, time zone(s), and more.
After you've chosen your settings, click on
the OK button.
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EVENT: an activity that lasts at least 24 hours

Examples include a conference or a vacation. An annual event, such as an anniversary,
occurs yearly on a specific date, while a standard event occurs once and can last for one
day or several days.

Events and annual events appear in the calendar as banners, not blocks of time. An all-day
appointment displays time as Busy when viewed by others, while an event or annual event
displays time as Free.

I Untitled - Event Q@E'
P Fle Edt View Insert Format Tools  Actions  Help
Schedule an Event el soveand Cose | 4 ] | 3 Recurence.,| iflpvteAtencees | 1 8 |X |+ - o - (@ )
Appointment | Scheduling
1. Choose Actions = New All Day ot
Event Location: | Label: |[] Mone v
2. The Event dialog box appears. Satthe  Wenlolifme v GREr
3. Fill in Subject, Location, Start T el
Time, and End Tlme' [reminder: B¢ Showtime as: | [] Free v

4. Make sure All Day Event box is
checked (only difference between
Event and Appointment).

5. Click Save and Close.

sl

Schedule a Recurring Event

Appoiniment Recurrence Ll 1. Open a new All-Day Event form and click the
Appointrment time
Start; BN v End: 12:004M % | Duration: |1 day hs Recurren_ce bUtton' i
Recurence patten 2. The Appointment Recurrence dialog box
(O Daiky Regur every |1 wesk(s) ont OpenS; ﬂ“ |n |nf0rmat|0n and C|IC|( OK-
gmam Cloundsy  EMondsy  [iuesdsy  [wedmesdey 3. The Event dialog box appears; complete your
onth i A . .
oy || e Dlmay - Dl information, then click Save and Close.
Range of recurrence - .
Start: [fron 107112004 | ©MNoend dete To edit an event: Double-click the event on your
S lcfiers LMl wemrenes calendar. Outlook opens the event form so you can

Ocndby: (Mo 1211572004 “ | change time, date, and other details.

£ 1 Reminder

Note to Self...

:ﬁ Budget Meeting

Start kirme: Manday, October 11, 2004 10:30 AM

oo o SR Outlook will remind you of your

appointments and meetings if you select the
Reminder checkbox in the Appointment or
Event dialog box.

Subject Due in

get Meeting 15 minutes

When the alert appears, you can either
Dismiss it or press the Snooze button to

opentton | [ oo | be reminded again.
Click Snooze ko be reminded again in:
5 minutes before start v
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Sharing and Delegating Items and Folders

Outlook on the Exchange server lets you share items and folders a couple of ways.

Use this:

To do this:

Shared Private Folders Give one or more persons permission to read, modify, create,

Delegate Access

or delete information in one or more of your private folders.
Example: You want your manager to see your calendar.

Give someone permission to send messages on your behalf,
accept meeting and task requests for you, or manage
information in your private folders. Example: You want
someone to help you manage your e-mail and calendar.

Calendar Properties @

General

Hanna, Tom
Carroll, Patrice
Curry, Melissa
Hopkins, Kyle
Cornetk, Betsy

Home Page

Permissions Synchronization ti me)

Administration Farms

Autodrchive To set SHARING permissions (one folder at a

Permission Level:

Add...

Reviewer 1. If the Folder List is not visible, click View > Folder
Reviowr List
Revicwer 2. Right-click the folder you want to share, and then

| [ Remove click Properties on the shortcut menu.

Permissions

Petmission Level:

|:| Create items
[Jread items

Edit items
@ Mone
O own
Oal

Mone

[ create subfolders

[CJEolder owner

Folder visible
Delete items

3. Click the Permissions tab.
W 4. Click Add.

5. In the Type Name or Select from List box, type
or select the name of the person to whom you want
to grant sharing permissions.

®None 6. Click Add, then click OK.
Oown 7. In the Name box, click the name of the person you
il just added.

8. In the Roles box, click the permissions you want,

l

OF

H Cancel ] then C||Ck OK.

In this Role:

Owner

Publishing Editor

Editor

Publishing Author

Author

Reviewer

Contributor

You have these permissions:

Create, read, modify, and delete all items and files and create
subfolders, and change the permission levels others have for the
folder.

Create, read, modify, and delete all items and files, and create
subfolders.

Create, read, modify, and delete all items and files.

Create and read items and files, create subfolders, and modify and
delete items and files you create.

Create and read items and files, and modify and delete items and files
you create.

Read items and files only.

Create items and files only. The contents of the folder do not appear.
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DELEGATE Access

To give another person delegate access means that person has “send-on-behalf-of”
permissions; if the delegate has access to your Inbox, the delegate can reply to your mail
on your behalf. Message recipients see the manager's name in the Sent On Behalf Of box
and the delegate's name in the From box.

The delegate can also organize meetings on your behalf, respond to meeting requests
sent to you, and respond to task requests sent to you.

Delegate Permissions: Hopkins, Kyle @ To grant Delegate access:

1. Go to Tools = Options
2. Select Delegates tab

This delegate has the following permissions

ﬁ (o= =T S ditor (can read, create, and modify items) RS 3 Clle Add button tO get Add Users dlalog
Delegate receives copies of meeting-related messages sent to me bOX

z Tasks Editor {can read, create, and modify items) 4. In Add Users bOX, SeIeCt name Of person

— you want as delegate and click Add, then

E:] Inbox Mone w OK

€| contects [none 3 5. The Delegate Permissions box will

appear; select the permissions you want,
J Motes Mone w CIiCk OK
\:ZDDJ Journal Maone w

Tip: If you have granted someone Delegate

[] Automatically send a message to delegate summarizing these permissions acceSS, you can Stl” keep items out of their
[pelegate can see my rivats tems view. Open the item and click the Private
[ o [ cocel | check box in the bottom right corner of the

item’s form (as long as you haven't selected
“Delegates can see my private items” on the Delegate tab).

A delegate must have both Editor permission in a manager's Calendar or Tasks folder and
Reviewer permission in the manager's Inbox to accept meeting or task requests for the
manager. HOWEVER -- If a manager selects “Send meeting requests and responses
only to my delegates, not to me"” on the Delegates tab (Tools = Options), then the
delegate does not need Reviewer permission in the manager's Inbox because the meeting
requests and responses will go directly to the delegate's Inbox.

In this role: You can:

Author Read and create items, and modify and delete items you
create. (Example: create task and meeting requests in
the manager's Task or Calendar folder, and then send
either item on the manager's behalf.)

Editor Read and create items, and modify and delete any item.
(Example: reply to messages, task requests, and
meeting requests for the manager).

Reviewer Read items only (Example: read messages in another
person's Inbox).

Custom Perform activities defined by the manager.

Note: If you have Author or Editor permission, any items you create while the shared
folder is active are stored in the other person's folder.
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To open another person's folder

1. Go to File & Open, and then click Other User's Folder.

2. In the Name box, type the name of the person who granted you sharing or delegate
access permission, or click Name to select from a list.

3. In the Folder box, click the folder you want to open.

To schedule an appointment for another person

(If you are not a delegate, you must have Author or Editor permission to do this.)
Open the other person's Calendar.

Go to File & New, and then click Appointment.

In the Subject box, type a description.

In the Location box, enter the location.

Enter Start and End times.

Click Save and Close.

ouhwNE=

To schedule a meeting for another person

Open the other person’s Calendar.

Go to File & New, and then click Meeting Request.

In the To box, type the attendee names or click To to select from a list.
In the Subject box, type the location of the meeting.

In the Location box, type the location of the meeting.

Enter the Start and End times.

Select other options you want.

Click Send.

XN AWM=

To respond to meeting requests for another person as a delegate

1. Open the other person’s Inbox if their meeting requests are not being sent directly to
you.

2. Open the meeting request.

3. Click Accept, Tentative, or Decline.
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Organize Your Email

Tips for effective email management:

1. Reserve your Inbox for messages that are most likely to require your immediate
attention. Everything else can be filtered out to an appropriate folder.

2. Create a folder and associated rule for all listserve messages to clear your Inbox for
higher priority messages, and visit the listserves messages when time allows.

3. Use colors and fonts to draw your attention to important messages.

While in any Outlook folder you can open the Tools menu and click on the Organize button
to open a panel that contains useful shortcuts. When in a mail folder, one of the options
offered is to move the selected message to another folder. You can also create “rules”
(more on these later) by clicking on the Rules and Alerts button.

Also available from the Organize panel is the ability to apply colors and formatting to
selected messages. For example, you could make messages from your boss catch your eye
by having them appear in red. From the Automatic Formatting option in the upper right

hand corner you can change the color, style and size of the font used for any message or
series of messages.

Using the Organize feature

1. Open the Inbox folder. (For some options you will need to have messages in the

Inbox.)

Inbox - Microsoft Outlook E|E|@
! File Edit Wew Go Tools Actions Help Type a question for help (=
[3dNew - | = 3 X | “&Reply dReplyto Al 12 Farward | ;_14 SendfReceive - | _‘?pFi_pd [ | i BobHarna - | (7] @ @!
Pt | @Back @) | (A[H] 3| 9 [ 5] Messages =224

1 ize Mew Folder... | Rules and Alerts. .. | X

All Folders

= @ Unger, Manci A @ Move message selected below to @h_n_xivl

E E:::tljadc‘:; L To view or edit yvour rules, and For more advanced options, click Rules and Alerts' above.

&) Deleted Items
L7 Drafts [16]
= [ Inbox
= [ $Executrain
[ $cancelled
[ $correspondence Inbox -

1 $Intermediate Reg 5 PR i
NEmEsEierron A Special Invitation-Work-Life

H [ $wWant Mext Class
[ Answers! Event Oct. 19th

Arranged By: Date

[ Brio ete, = Today _ Flambeck, Mary Carol
[ Certificates (1 Hanna, Tom 1013 808

Monday

[ Classrooms
[ EVC
[ Inventary
H [ Keepers

To:  Akin, Tammy; Andal, Diane; Anderson,

Pat; Austin, Janice; Bailey, Michele; Bell-
Attachments: %] work-Life-Flyer.gif (39 KB)

| Kenwick u;. Livingston, Darren 943 AN
[ listservs F Lab machine 106-09 - .
e e ~|| & williams, Russ Sea To HR Staff: Anached is an
é | E Fiii ! ' i invitation to attend a special Work-
PR - - : Life event to be held on Tuesday.
Jﬁﬁz o [\ E‘ 2 {| i1 Price, Douglas 911 AM 3 e Sl it i R
1865 Ttems | ©] online

2. Open the Tools menu and click Organize. The Ways to Organize Inbox dialog
box will open at the top of the message pane.

3. Three options are available on the left side of the dialog box: Using Folders, Using
Colors, and Using Views. You can do any of the following:
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« Click Using Folders to create new folders, open Rules and Alerts (Rules
Wizard), and move messages to other folders. You can easily create a rule
to move messages from a certain sender into another folder upon

delivery.

« Click Using Colors to color code messages by sender.

« Click Using Views to select how you see messages in your Inbox.

4. When you are finished, click the X in the upper right corner to close the dialog box.
You can also organize messages that have already been moved to other folders by opening

the Tools menu and then clicking the Organize button.

Rules

Rules and Alerts
E-mail Rules | Manage alerts

[ Mew Rule... Change Rule » 53 Copy... X Delete |

# Run Rules Mow... Options

Rule {applied in the arder shown)

sparm
kermick {client-onky)
UKSTAFF@LSY, UKY. EDU (E-mai)

Move messages sent From MY Times, com Ad-Mail or Half.com by eBay ...

Actions

Rule description {click an underlined value to edit):

Apply this rule after the message arrives

From MY Times,com Ad-Mail or Half, com by eBay or Weknews or Hallmark or WY Timescom or Cert?1,com or Exe

move it ko the stuff Folder

Ok

] [ Cancel

specific recipient.

An email rule (sometimes
referred to as a filter) will search
messages for specified
characteristics and perform an
action on messages that have
the desired traits.

For example, you can:

e Filter out messages from
a particular sender or
listserv and automatically
move them into the
appropriate folder.

e Put a color or importance
stamp on messages from
a specific sender.

e Print a copy of every
email you send to a

Rules are primarily used to help manage incoming mail, although they can also be used on

existing or sent messages.

The most common type of rule is one that checks messages when they arrive. You can also
apply rules to messages after you send them or if they've already been moved out of the
Inbox. (Note: Filtered or moved messages will still appear as unread.)

For basic rules, Outlook provides the Rules and Alerts feature, also known as the Rules

Wizard.
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(©i5tart creating a rule from 2 kemplate:
() 5tart from a blank rule

Step 1: Select a template
Stay Organized

3 Move messages with specific words in the subject to a folder
5 Move messages sert to a distribution list to a Folder
X Delete a conversation
¥ Flag messages From someone with a colored Flag
Stay Up to Date
= Display mail From someone in the Mew Ttem Alert Window
il Play a sound when 1 get messages From someone
a Send an alert to my mobile device when 1 get messages from someone

Step 2: Edit the rule description {click an underlined value)
Apply this rule after the message arrives

From people or distribution lisk
move it ko the specified Folder

Example: Move mail from my manager to my High Importance folder

Rules Wizard

‘hich condition(s) do wou want to check?
Step 1: Select condition(s)

i
[ theough the: specified account
[ sent only to me
where my name is in the To box
[ marked as importance
] marked as sensitiviy
[ Flagged For action

[ where my name is in the Cr b

[] where my name is in the To or Cc box

[ where my name is not in the To box

[ sent to people o distribution list

[ with specific words in the body b

Skep 2: Edit the rule description {click an underlined value)

Apply this rule after the message arrives
from people or distribution list
move it to the specified Folder

Cancel ][ < Back ” Iext » ][ Finish ]

Rules Wizard

X

‘What do vou want to do with the message?
Skep 1: Select action(s)

[ o th Folder s
] assign it ko the cateqory category
] delete it

] petmanently delete it

[ move a copy to the specified folder

[ Forward it ko people o distribution list

[ Forward it to people or distribution list as an attachment

[ redirect it o people or distribution list

[ have server reply using a specific messane

[ reply using a specific template

[ Flag message For sction in a number of days

[ Flag message with a colored Flag

[] clear the Message Flag v

Step 2: Edit the rule description {click an underlined value)
Apply this rule after the message arrives

from Unger, Manci
move it ko theiEYC Folder

Cancel ][ < Back ” Mext = ] [ Finish
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Using the Rules Wizard

1. While in the Inbox, open the Tools menu
and click Rules and Alerts.

2. Click New. Choose to start creating the rule
from a template or from a blank rule.

Select the type of rule

Begin by selecting "Check messages when they
arrive." Click the Next button to move forward
through the Rules Wizard.

Set the criteria for the rule

Now choose the criteria that the rule should look
for. The first thing to ask when creating a rule is,
“what is it about this type of message that will
differentiate it from all other messages?”
Generally, a message to an email list has the name
of the list in the To: field.

For example, to apply a rule to messages from the
UKSTAFF listserv, you would:

1. Scroll down and select “with specified words
in recipients address."

2. In the description box below, click on the
highlighted "specified words."

3. Enter the name or a part of the name of the
list, in this example UKSTAFF@LSV.UKY.EDU

4. Click the Next button.

Next, you will need to select a condition (or
conditions) that you would like to check for. To
select one, click the box to the left of the text. A
check mark will appear. To remove the condition,
click the box again.

If there is an underlined option in the "Rule
description" box that you have not edited, click it to
change the option.

Click the “Next” button.

Now select what you want to do with the message.
Check the option (or options) you want. If there is
an unedited underlined line of text, click it to
specify its value.
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Click the Next button.

Frsh e setup. Check exceptions (if any) to your rule. Again, if
Step L1 Specky a pams for this rule there is an unedited underlined value, click it to
EWC spedial .

specify the value.

Step 2t Setup rule options

[]Run this rule now on messages already in "Inbox" C I | Ck th e Next butto n.

[¥] Turr on this rule

Select any necessary options and click the Finish

Step 3 Review rule description {click an underlined value ko edit) butto n.
Apply this rule after the message arrives
From Unger, Manci . . .
mave I 1o the EVC fokder Your rule will now be set to filter your mail
accordingly.

Outlook Web Access

You can access your Outlook email on the Web! Go to the site:

http://exchange.uky.edu
and the Microsoft Exchange Server screen will appear. (You can change your Outlook
password from this screen.) Click on “Microsoft Outlook Web Access.” A login box will
appear. The login box will ask for your Outlook userid and password. You will need to type
your domain (ad for “Active Directory”) with a backslash in front of your userid:

ad\userid
Then enter your password and click the OK button. Outlook will open and you can access
your email, calendar, contacts, and folders. When you are ready to exit Outlook, be
sure to click on the Logout link and then close your browser.

TIP - Add the Outlook Web Access site to your browser bookmarks so you can find it easily.
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